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Introduction

1

PST Importer is an extension to the Metalogix Archive Manager for Exchange application and is

installed by default on the Metalogix Archive Manager for Exchange server. It is a handy tool for

importing PST files from one or more users in your organization. If there are a small set of PST

files, you can import these PST files manually. If there are a large number of users, you can install

the PST Gatherer component as an application or service on a user's computers and automate the

process of searching and loading the PST files into the PST Importer. This document describes

manual and automated importing in detail.

The term PST Importer server is used in this documentation. It is the same as the Metalogix

Archive Manager for Exchange server where PST Importer is installed.
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Installation

2

In this topic:

· Software Requirements

· Configuring Extended MAPI

· Installing PST Importer

Software Requirements

· Windows Server 2012 / 2016 / 2019

· .NET Framework 4.6.1 or higher

· Microsoft Outlook 32 bit

o For Exchange 2013, Outlook 2013 is needed.

o For Exchange 2016, Outlook 2013/2016 is needed.

o For Exchange 2019, Outlook 2019 is needed.

NOTE: All versions of Outlook specified above require the latest Microsoft Office service

pack and public updates.

Configuring Extended MAPI

Since Microsoft Outlook data files (PST files) are handled exclusively by Microsoft Outlook

Extended MAPI (the messaging API used by Microsoft Outlook), it is necessary to configure it

properly on the computer where importing of PST files takes place. PST Importer works with two

types of PST files: ANSI data files and UNICODE data files. 

The default Extended MAPI  cannot handle Microsoft Outlook data files, unless its configuration

file (MAPISVC.INF) contains messaging services to handle them. Therefore all messaging services

installed on the computer must be added to the MAPISVC.INF file.

· When no Microsoft Outlook is installed, then the MAPISVC.INF file is located in the C:

\Windows\system32 Windows system folder, and the Extended MAPI configuration is read

from this file.

· When Microsoft Outlook is installed, then another MAPISVC.INF file is installed in the C:

\Program Files\Common Files\System\MSMAPI\1003 folder, which includes the

messaging services for Microsoft Outlook.
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Since PST Imported uses the default MAPISVC.INF file is located in the Windows system folder,

this file must be updated with the Microsoft Outlook Extended MAPI file. To update Extended

MAPI configuration file (MAPISVC.INF), follow these steps:

1. Locate the MAPISVC.INF in the C:\Windows\system32 Windows system folder.

2. Locate the MAPISVC.INF in the C:\Program Files\Common Files\System\MSMAPI\1003

folder.

3. Make a backup copy of both files.

4. Replace the MAPISVC.INF file in the Windows system folder with the file located in the the C:

\Program Files\Common Files\System\MSMAPI\1003 folder. This will ensure that

Extended MAPI will be using the correct configuration file. If messaging services are missing in

the MAPISVC.INF file, no importing of Microsoft Outlook data files (PST files) will take place.

Note that some of the values are different on different computers. For more information see

Troubleshooting. 

5. When the default MAPISVC.INF in the Windows system folder has been updated, close all

applications which are using the Extended MAPI to reload MAPISVC.INF.

Installing PST Importer

PST Importer is installed by default when you install Metalogix Archive Manager for Exchange. If

it has not been installed, see the Metalogix Archive Manager for Exchange Advanced Installation

Guide. Look for the topic Install the Archive Server in the Advanced Installation section. 

When installing the Metalogix Archive Manager for Exchange you will be prompted to select the

individual features. In the Select Features window, select the PST Importer feature and proceed

with the installation. 
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Configuration

3

PST Importer must be configured before use to set up critical folders for operational use and

specify a default mailbox and folder for PST imports. To configure the PST importer, follow the

steps described below:

In this topic:

· Steps to open the Options window

· Folders tab

· Analyze tab

· Default tab

· Archive tab

Steps to open the Options window

1. Click Start > Programs > Metalogix > Archive Manager Exchange > PST Importer to start the

application.

2. From the Tools menu click Options to open the Options window and review or revise the

properties in each tab as described below.

3. Click Apply to save and continue or click OK to save and exit the Options window. Click Cancel

to exit the window without saving any changes.
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Folders tab

The Folders tab specifies the location of the folders that are used for various operations of the

PST Importer. A default location for each folder is already specified and you can modify them as

needed.

All the folders are created by default under C:\Program Files (x86)\ Metalogix\

MAM4Exchange\PST. You may select another location by clicking the Browse button and

selecting another folder.

Import folder - Microsoft Outlook data files can reside anywhere on the computer. When opened

by PST Importer they are copied from their original location to the Import folder for further

processing. When all items from a PST file are successfully archived, then the PST file is deleted

from the Import folder.

Error folder - Stores the PST files which were not imported because of an import error. not all

items from a desired . The PST file is moved from the Import folder to the Error folder.

Processed folder - Stores the PST files which were not imported because one or more messages

could not be archived. The error can also happen if the option Move non-archivable messages to

mailbox is not selected in the Default tab. The PST file is moved from the Import folder to the

Processed folder.

Log folder - Stores the log files generated by PST Importer. Log files are used for recording all the

actions on PST files (e.g. analyze, report, etc.).

Create a new log file for each action - By default, all logs are written into one log file. Select this

check box to create a new log file for each action on a PST file (e.g. analyze, report, etc.). 
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Analyze tab

The Analyze action helps to identify a suitable owner in the destination mailbox for messages in

PST file depending on the frequency of occurrences in the sender and recipient list. The Analyze

action counts the senders and recipients from all emails in the PST file and generates a count. A

ratio is calculated for each recipient and sender by dividing the total number of occurrences of

recipients in the recipient list and senders the sender list by the sum of recipients and senders.

The ratio is displayed as a percentage. The user with the biggest ratio indicates the most suitable

destination mailbox or owner of the messages in the PST file and would therefore be

automatically assigned as the default owner. 

Always analyze the PST file before import - Select this check box to every manually loaded PST

file is analyzed.

Lowest distinguishing ratio (%) - There could be several users with a marginal difference in the

ratios. Set this value to determine how the default owner is assigned as described below:

· If the difference between the two highest ratios is higher than the Lowest distinguishing ratio,

then the owner is assigned tot he mailbox user with the highest ratio.

· If the difference between the two highest ratios is lower than the Lowest distinguishing ratio

then:

o Assign to user who has the most "From" count - select this option to assign the user with the

highest "From" count as the default owner of the PST file that was analyzed.

o Assign to user who has the most "To" count - select this option to assign the user with the

highest "To" count as the default owner of the PST file that was analyzed.
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o Always ask - you will be prompted to manually assign an owner of the PST file that was

analyzed.

NOTE: If an assigned user does not exist on the Exchange server, or the assigned user exists

but has not been synchronized with Archive Manager, the default owner configured in the

Default tab will be used.

Default tab

This tab defines the default properties that are used during a PST file import when these

properties are not defined for the PST file being imported.

Owner - the destination mailbox that will be used to load the messages from a PST file.

Destination folder - the root folder for all messages that are loaded from a PST file. If the folder

does not exist in the destination mailbox, the folder will be created. 

NOTE: If you intend to import more than one PST file to the same destination mailbox, you

can create unique root folders for each PST file by entering the special tags described

below:

a. %PSTNAME% - the folder name is the display name of the PST file.

b. %PSTFILENAME% - the folder name is the file name (without extension) of the PST file

For example, if Maya-2019.pst is the file name of the PST folder being imported and you

enter PST Archive/%PSTFILENAME% in the Destination folder, then a folder hierarchy

will be created under the destination mailbox root as PST Archive > Maya-2019.
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Alternate folder - This property is required if the Destination folder is blank. If there are any

messages in the root node of PST file, then these messages will be will be imported to this

folder. If this folder does not exists in the destination mailbox, the folder will be created

automatically. All other items will be imported to the  respective folders of destination mailbox

and non-existent folders will be created automatically.

Always create the whole folder tree - select this check box to create the entire tree structure of

the PST file in the destination mailbox including folders that are empty. When this option is not

selected, empty folders in PST file will not be created in the destination mailbox. 

Move non-archivable messages to mailbox - select this check box to move all non-archivable

messages like already archived, shortcuts and undefined message classes to the destination

mailbox. If this option is not selected, the messages that cannot be archived are not moved to the

destination mailbox and the PST file is subsequently moved to the Processed folder when the

import completes. 

Clear existing list before a new search - select this check box to clear the search results list in the

Gather management window every time you search for PST files. In this way the old search

results will be deleted and only the new results will be included in the list.

Archive tab

Allows you to specify the compression and retention for messages imported through PST

Importer.

Compress MSG files - select this check box to compress messages when they are archived.

Compress attachments - select this check box to compress attachments when they are archived.

Retention category - select a predefined retention category from the down-drop box. If no

retention category is selected, the default retention category set in the Archive Manager will be

used.
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Log files

4

Each action on a PST file is logged in one or more log files. Logs are written to a single file or

action-specific files based on the configuration settings. For more information see the Folders

tab section.

Steps to view log files

1. Open PST Importer.

2. Click the File menu and then select View log file.

3. The log files are displayed in the Log Files window. This list can be sorted by name, date or size

by clicking the respective column header.

4. Double-click a log file or select a log file and click Show. The contents are displayed in the

ViewLogFile window.
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Manual import

5

Manual import of Microsoft Outlook data files is a three-step process:

1. Loading a PST file

2. Preparing a PST file

3. Importing a PST file

Optionally, you can review and configure each PST file with the following features:

· Viewing a PST file summary

· Analyzing a PST file

Loading a PST file
To load a PST file follow these steps:

1. Open PST Importer.

2. From the File menu click Add PST file. 

3. In the Open window locate the PST file and then click Open.
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4. The file will appear on the Import tab. The PST file is stored in the Import folder as specified in

the Folders tab under Tools > Options.

NOTE: To successfully load the PST file, it cannot be used by another program on the

client’s computer. To remove a PST file from the list, select the file. Then right-click and

select Remove PST file from the context menu.

Preparing a PST file
When a PST file is loaded, it is automatically assigned the default owner and the default

destination folder. These defaults reference the default settings of the PST Importer.

To set a specific owner and specific destination folder for a PST file, follow the steps described

below:

1. Right-click the PST file and select Settings from the context menu or double-click the desired

PST file.
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2. In the PST Properties window click the Settings tab. The PST Properties window opens.

3. Specify the property values as described below:

4. Target mailbox - click Browse to open the Select mailbox window and choose the new owner

mailbox.. You can also right-click the PST files and select the Change owner from the context

menu. Click Default on the Settings tab, to revert the Target Mailbox to the default owner. You

can also right-click the PST files and select the Change owner to default from the context

menu . 

5. Specific folder - either type the mailbox folder name in the text box or use the Browse button

to select a mailbox folder.
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NOTE: If you intend to import more than one PST file to the same target mailbox, you

can create unique root folders for each PST file by entering the special tags described

below:

a. %PSTNAME% - the folder name is the display name of the PST file.

b. %PSTFILENAME% - the folder name is the file name (without extension) of the PST

file

For example, if Maya-2019.pst is the file name of the PST folder being imported and you

enter PST Archive/%PSTFILENAME% in the Destination folder, then a folder hierarchy

will be created under the destination mailbox root as PST Archive > Maya-2019.

6. If the PST file was password protected, click the Password tab. Then enter the password in the

Password field and re-enter the password in the Confirm password field.

7. Click Apply to save and continue or click OK to save and exit the PST Properties window. Click

Cancel to exit the window without saving any changes.
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Viewing a PST file summary
The PST file summary provides an overview of the PST file that includes its structure, folder size

and number of items in each folder. To view the summary follow the steps below:

1. Right-click a PST file and select Info from the context menu. If the PST file is password

protected, you must specify the password in the Password tab of the PST properties window.

2. The summary info displays only the size and structure of the PST file by default.

3. To view the Size of the folders click Folder size.
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Analyzing a PST file
To analyze a PST file follow the steps described below:

1. Right-click a PST file and select Analyze selected from the context menu. If the PST file is

password protected, you must specify the password in the Password tab of the PST properties

window.

-or-

Select the PST file. Then click Analyze from the menu and select Analyze selected.
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NOTE: To analyze all PST files at once, select Analyze all.

2. The Analyzer progress window opens and displays the progress of the analysis of one or more

PST files.

3. When the analysis completes, the Result of analysis window displays the results.

4. The left-hand side of the window lists the PST files. If a valid owner could not be determined

from the results of the analysis, the currently assigned user is set to unknown. When you click

on a PST file, the right-hand side displays the list of senders and recipients. If no user has be

assigned as the owner of the PST file, double-click the user you want to select or select the

user and click Assign. 

5. When the PST files are ready, click Close to close the window. All PST files will be saved with

the changes.

6. When the owner is assigned either automatically or manually, the new settings will be

displayed on the Import tab.
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Analysis Results

1. Users displayed with the red cross icon ( ) are considered invalid users because they do not

exist on the Exchange server or have not been synchronized with the Archive Manager server.

You cannot assign the default user of PST file to invalid users.

2. Analysis results are based on the settings in the Analyze tab of the PST Importer configuration

options.

3. If the PST file has a single user, a 100% ratio is attained as the outcome of the analysis. The

user is assigned automatically as the owner of the PST file if the user is a valid user. If the user

is invalid, the Assign button remains inactive and the default owner configured on the PST file

will be used.

4. If there are two or more valid users and the difference between the two highest ratios is

higher than the Lowest distinguishing ratio, then the valid user with the highest ratio is

assigned automatically as the owner of the PST file.

5. If there are two or more valid users and the difference between the two highest ratios is

lower than the Lowest distinguishing ratio, then:

a. If the Assign user who has the most "From" count option is selected then the user with the

highest "From" count is assigned automatically. If the "From" count is identical for several

users then the user with the highest ratio is assigned automatically. 

b. If the Assign user who has the most "To" count option is selected then the user with the

highest "To" count is assigned automatically. If the "To" count is identical for several users

then the user with the highest ratio is assigned automatically. 

6. If the Always ask option is selected then you will be asked to select the owner. 
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Importing a PST file
To import one or more PST files follow the steps described below:

1. Right-click the selected file and then select Import selected from the context menu.

-or-

Select the PST file. Then click Import from the menu and select Import selected.

NOTE: To import all PST files at once, select Import all.

2. When the PST file import process completes, a Status message box appears. Select OK to close

the Status message box.

Depending on the import status, the following actions occur:

a. If the import was successful and all items including non-archivable items were imported,

the PST file is removed from the Import tab and deleted from the Import folder.
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b. If the import was partially successful and one or more non-archivable items could not be

imported, the PST file is moved to the Processed tab and the physical file is moved from

the Import folder to the Processed folder.

c. If the import failed and one or more items could not be imported due to an error, the PST

file is moved to the Error tab and the physical file is moved from the Import folder to the

Error folder.

It is recommended that you check the log file after import. See Log files  for more information.

Managing PST files with import problems

PST files can be moved from the Error tab or Processed tab back to the Import tab to modify their

settings and retry the import. To move a PST file:

1. Right-click the PST file displayed in the Error tab or the Processed tab.

2. From context menu, select Move to import. The file will be moved back to the Import tab.

 

3. When a PST file is moved back to the Import tab, the physical file is moved to the Import

folder. Messages that were successfully imported are removed from the file. As a result, PST

Importer will attempt to import the remaining messages.

NOTE: If the import fails and the user reloads the original PST file, then duplicate emails

will be imported – those from the first import and those from the second import.
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Automated import

6

Automated import uses a complementary application called PST Gatherer to collect PST files from

client computers. These files are then automatically uploaded to the PST Importer server where

they can be manually imported and archived. Automated import is recommended for large

organizations so that the manual process of collecting and uploading PST files from client

computers is automated.

1. When PST Gatherer is installed as an application or a service on the client computer, it

searches through local and network drives as permitted and uploads the PST file to the

specified PST Importer server.

2. When a client computer is registered in the PST Importer server, a sub-folder for each client

computer is created in the C:\Program Files (x86)\Metalogix\MAM4Exchange\PSTs folder.

Each PST file that is uploaded from the client computer will be stored in a unique sub-folder in

the client computer folder.

3. The administrator uses the PST Import wizard to import the PST files stored on the server

computer from C:\Program Files (x86)\Metalogix\MAM4Exchange\PSTs\<client-

computer-name> to their destination mailboxes and destination folders and subsequently

archives the email items.

Requirements

1. PST Gatherer must be installed on all client computers from where PST files are gathered.

2. Firewall permissions must be granted to the PST Gatherer that is installed on the client

computers.
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3. The PST Gatherer application or service must be started.

4. The client computer must be registered in the PST Importer server.

Install PST Gatherer
In this topic:

· Steps to manually install PST Gatherer

· Steps to automatically install PST Gatherer

· Steps to verify the PST Gatherer installation as an application

· Steps to verify the PST Gatherer installation as a service

· Configuring PST Gatherer to communicate through a firewall

· Steps to repair the PST Gatherer installation

· Steps to remove the application or service

Steps to manually install PST Gatherer

1. Double-click <install-media-folder>\Metalogix\Archive Manager Installation

Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.exe 

2. Click Next. The License Agreement window opens. Select I accept the terms in the license

agreement.
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3. Click Next. The Destination Folder window opens. Keep the default or click Change to select

another installation location. 

4. Click Next. The Install Types window opens.
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5. Select an option to install PST Gatherer either as a service or an application as described

below:

a. Application - Users keep PST files not only on local drives, but also on the network shares

and selecting this option allows PST Gatherer to search and gather PST files from the local

drives and network shares where the current user has access rights.

b. Autostart - when selected, the PST Gatherer application will start whenever the user logs

on.

c. Show in tray - when checked, a tray icon for this application will be displayed.

d. Service - selecting this option ensures that PST Gatherer runs as LOCAL SYSTEM which has

limited rights to search files on the local drives only.

6. Click Next. The Configuration window opens.



28
Automated import

Meta logix Archive Manager for Exchange PST Importer Guide 

7. Enter the information as described below:

a. PST Importer server name - enter the name or click Browse to locate the Archive Manager

server.

b. Allowed drive list - Enter one or more drive letters that can be searched for PST files.

Separate the letters with the pipe (|) character. You can enter an asterisk (*) to indicate all

drives.

c. Blocked drive list - Enter the drive letters that can be searched for PST files. Separate the

letters with the pipe (|) character. For example A|B will prevent floppy drives A and B

from being searched.

d. Allow to search network drives on the client - select this check box to permit PSTGatherer

to search the specified network drives.

8. Click Next. The Ready to Install the Program window opens.
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9. Click Install. When the installation completes, the InstallShield Wizard Complete window

opens.

10. Click Finish to complete the installation.
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Steps to automatically install PST Gatherer

Setup is available in two options:

· MSI Setup 

· EXE Setup 

You can create a silent setup with custom property values and the command option /qn

MSI Setup

Installer file location

<install-media-folder>\Metalogix\Archive Manager Installation
Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.msi

Syntax

msiexec /[option] [msi installer file location] PROPERTY=VALUE
PROPERTY2=VALUE PROPERTY3=VALUE....

Property values that are literal strings must be enclosed in quotation marks. 

 spaces can be included in the string between the marks.

msiexec /[option] [msi nstaller file location] PROPERTY="Embedded White
Space"

Examples

Action Command

First install msiexec /i [msi installer file location]
or
msiexec /i [msi installer file location]
PSTSERVER="AMXSERVER"

Repair msiexec /i [msi installer file location]
REINSTALL=ALL REINSTALLMODE=vomus

Change import server name msiexec /i [msi installer file location]
REINSTALL=ALL REINSTALLMODE=vomus
PSTSERVER="AMXSERVER"

Logging msiexec /i [msi installer file location] /l*v
[path to PSTGathererLog.txt file]

Uninstall msiexec /x [msi installer file location]

Silent mode msiexec /i [msi installer file location]

PSTSERVER="AMXSERVER" /qn 
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NOTE: For more information related to msiexec command-line options see

http://msdn.microsoft.com/library/default.asp?url=/library/en-

us/msi/setup/command_line_options.asp

EXE Setup

Installer file location

<install-media-folder>\Metalogix\Archive Manager Installation
Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.exe

Syntax

[exe installer file location] /v"PROPERTY=VALUE PROPERTY2=VALUE
PROPERTY3=VALUE"

Property values that are literal strings must be enclosed in quotation marks. White spaces can be

included in the string between the marks.

[exe installer file location] /v"PROPERTY="Embedded White Space"

Command-line options that require a parameter must be specified with no space between the

option and its parameter. For example, PST Gatherer

Setup.exe /v"PSTSERVER=testdemo" is valid, whereas PST Gatherer Setup.exe /v

"PSTSERVER=testdemo" is not. Quotation marks around an option's parameter are required

only if the parameter contains spaces.

If a path within a parameter contains spaces, you may need to use quotation marks within

quotation marks, as in the following example: PST Gatherer
Setup.exe /v"INSTALLDIR=\"C:\My PST Files\""

Examples

Action Command

First install [exe installer file
location] /v"PSTSERVER="AMXSERVER""

Repair [exe installer file location] /v"REINSTALL=ALL
REINSTALLMODE=vomus"

Change import server name [exe installer file location] /v"REINSTALL=ALL
REINSTALLMODE=vomus PSTSERVER="AMXSERVER""

Logging [exe installer file location] /v"/l*v \"C:\My
logs\PSTGathererLog.txt""

Uninstall [exe installer file location] /v"/x"

Silent mode [exe installer file
location] /v"PROPERTY="value" ... /qn"

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/command_line_options.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/command_line_options.asp
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Properties

It is possible to change the default registry and config key values and set your desired values with

PSTGatherer command line options. If no PSTGatherer cmd option is specified, default values will

be used. Specifying values with properies is needed only in for silent installation.

Property Value Description Note

INSTALLDIR [ProgramFilesFol
der]
\Metalogix\MAM4E
xchange\PSTGathe
rer

Path to the

installation directory
CAUTION: Use only

with first install if

you wish to change

the default location.

INSTALLTYPE 1 - (default)

PSTGatherer is

installed as an

application

2 - PSTGatherer is

installed as a service

Indicates the type of

installation for the

PSTGatherer

CAUTION: Use only

with first install.

Once PSTGatherer is

installed as an

application, it cannot

be changed to a

service. If you want

to change it to

service, you have to

uninstall it and then

install it again with

new settings.

GATHERERID 0 - no icon is

displayed on the

taskbar

1 - (default) shows

the icon on the

taskbar

Indicates whether or

not an icon tray

should be displayed

on the taskbar.

NOTE: Can be used

only if PSTGatherer

is installed as an

application with

INSTALLTYPE = "1"

If PSTGatherer is installed

as an application

(INSTALLTYPE="1") then

the setup program creates

the GATHERERID registry

key of type REG_DWORD at

the following location:

HKEY_LOCAL_MACHINE\SO
FTWARE\Wow6432Node\Me
talogix\PAM4Exchange\
PAMGatherer



33
Automated import

Meta logix Archive Manager for Exchange PST Importer Guide 

AUTOSTART 0 - removes the

PSTGatherer

application from

Start/Programs/Start

up

1 - (default) adds the

PSTGatherer

application under

Start/Programs/Start

up

Indicates whether or

not the PSTGatherer

should start when

the user logs in to

the computer.

If PSTGatherer is installed

as an application

(INSTALLTYPE="1") then

the setup program creates

the AUTOSTART registry

key of type REG_DWORD at

the following location:

HKEY_LOCAL_MACHINE\SO
FTWARE\Wow6432Node\Me
talogix\PAM4Exchange\
PAMGatherer

PSTSERVER Localhost NETBIOS name of

the PST Importer

server. Must be used

with This name is

written to the

configuration file.

CAUTION: Use only

with first install if

the PST Importer

server is not the

localhost.

SEARCHNETWORKDR

IVES

0  - (default)

PSTGatherer is not

allowed to search

network drives on

the given computer

1 - PSTGatherer is

allowed to search

network drives on

the given computer;

if this is the case,

specify which drives

are allowed and

which are

deactivated with the

ALLOWEDDRIVES

and

DEACTIVATEDDRIVES

properties.

Permits or denies

PSTGatherer to

search the specified

network drives.

ALLOWEDDRIVES * (default) Indicates drives that

can be searched for

PST files. Separate

the letters with the

pipe (|) character.

You can enter an

Used only if

SEARCHNETWORKDRIVES-"

1" 
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asterisk (*) to

indicate all drives.

DEACTIVATEDDRIVES A (default) Indicates drives that

can be searched for

PST files. Separate

the letters with the

pipe (|) character.

For example A|B

will prevent floppy

drives A and B from

being searched.

Used only if

SEARCHNETWORKDRIVES-"

1" 

Besides the registry keys mentioned above, configuration keys in PSTGatherer config file can be

specified through properties. By default, the PSTGatherer configuration file is present at the

following locations:

· If PSTGatherer is installed as an application

[InstallDirectoryPath]\Application\exchangePAMGatherer.exe.config

· If PSTGatherer is installed as an service

[InstallDirectoryPath]\Service\PAMPSTGathererSV.exe.config

Configuration keys

Key Default value Description Note

CLIENTPORT 4446 Port used on the

client 

Do not change.

CLIENTNAME  <ComputerName> Local computer name Do not change. It is

automatically

detected and filled in

by the setup.

CLIENTPROTOCOL tcp Protocol used on the

client

Do not change.

CLIENTMACHINE <ComputerName> Local computer name Do not change. It is

automatically

detected and filled in

by the setup.

SERVERPORT 9910 Port used on the PST

server

Do not change.
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SERVERPROTOCOL tcp Protocol used on the

PST Importer server

Must be the same as

on the PST Importer

server.

SERVERNAME localhost PST Importer server

name

This value must be the

NetBIOS name of the

PST Importer server.

SEARCHNETWORKDRI

VES

0 0  - PSTGatherer is not

allowed to search

network drives on the

given computer

1 - PSTGatherer is

allowed to search

network drives on the

given computer; if this

is the case, specify

which drives are

allowed and which are

deactivated with the

ALLOWEDDRIVES and

DEACTIVATEDDRIVES

properties. 

ALLOWEDDRIVES * Enter one or more

drive letters that can

be searched for PST

files. Separate the

letters with the pipe

(|) character. You can

enter an asterisk (*) to

indicate all drives.

Used only if

SEARCHNETWORKDRI

VES-"1" 

DEACTIVATEDDRIVES A Enter the drive letters

that can be searched

for PST files. Separate

the letters with the

pipe (|) character. For

example A|B will

prevent floppy drives

A and B from being

searched.
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Used only if

SEARCHNETWORKDRI

VES-"1" 

Steps to very the installation of PST Gatherer as an application

If the PST Gatherer is installed as an application and you have selected the Show in tray check box

during installation, then a tray icon will appear. Double-click it to open the Gatherer status

window with the Gatherer status and path to PST files.

Steps to very the installation of PST Gatherer as a service

After installing the PST Gatherer service on client computers make sure it is started. 

1. Click Start > Programs > Administrative tools > Services and verify that Status = Running for

MAM PST Gatherer.
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2. Also check if the Importer service is started on the PST Importer Server computer, by checking

the status of MAM PST Importer service.

NOTE: Restart the PSTGatherer service whenever it is updated or modified. To restart the

service, select MAM PST Gatherer and then click on the Restart Service icon on the toolbar.

Steps to allow PST Gatherer to communicate through a firewall on a
Windows 10 computer

1. Navigate to Control Panel > System and Security > Windows Defender Firewall.

2. Click the Allow a program or feature through Windows Firewall. The Allowed Programs

window opens.

3. Click Allow another program. The Add an App window opens. 

4. Click Browse to locate the C:\Program Files (x86)

\Metalogix\MAM4Exchange\PSTGatherer\Service\PAMPSTGathererSv.exe file.

5. Select PAMPSTGathererSv.exe and click Open.
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6. Verify that the PAMPSTGathererSv appears in the Apps list and then click Add.

7. Select the PAMPSTGathererSv and the Remote Assistance check boxes.
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8. Click OK to save and exit the window.

Steps to repair the PST Gatherer installation

1. Double-click <install-media-folder>\Metalogix\Archive Manager Installation

Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.exe 

2. Click Next. The Program Maintenance window opens.
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3. Click Next. The Configuration window opens.

4. Click Next. The Ready to Install the Program window opens.
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5. Click Install. The InstallShield Wizard Completed window opens.
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Steps to remove the application or service

1. Double-click <install-media-folder>\Metalogix\Archive Manager Installation

Package\Exchange\PST Gatherer\Archive Manager PST Gatherer Setup.exe 

2. Click Next. The Remove the Program window opens.

3. Click Remove. The InstallShield Wizard Completed window opens.
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4. Click Finish.

Setup PST Gathering
Default values must be set for all client computers where PST files will be gathered. All default

settings, such as default destination mailbox, default destination folder, start search time and

duration, start upload time and duration must be defined because these settings are inherited by

all client computers. Once defined they may be changed for any client computer as required.

In this topic:

· Steps to open the default settings window

· Steps to configure default ownership settings

· Steps to configure default search settings

· Steps to configure default upload settings

Steps to open the default settings window

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. 
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2. In the Gatherer management window click Clients from the menu and then click Default

settings.

3. In the Default Client Properties window specify the defaults in the Ownership, Search, and

Upload tabs as described below.

Steps to configure default ownership settings

1. Click the Ownership tab.
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2. Specify the default values as described below:

Assigned mailbox

a. Detect user from folder path - this setting is used for specific client computers. It remains

deactivated for default settings.

b. Assign user - Click Change to open the Select mailbox window and choose a default user

for PST import operations. Typically this is the administrator.

Options

a. Destination folder - the root folder for all messages that are loaded from a PST file. If the

folder does not exist in the destination mailbox, the folder will be created.
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NOTE: If you intend to import more than one PST file to the same destination

mailbox, you can create unique root folders for each PST file by entering the special

tags described below:

a. %PSTNAME% - the folder name is the display name of the PST file.

b. %PSTFILENAME% - the folder name is the file name (without extension) of the

PST file

For example, if Maya-2019.pst is the file name of the PST folder being imported and

you enter PST Archive/%PSTFILENAME% in the Destination folder, then a folder

hierarchy will be created under the destination mailbox root as PST Archive > Maya-

2019.

3. Click OK to save the settings and close the window or click Apply to save and continue.

Steps to configure default search settings

1. Click the Search tab.
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2. Specify the default values as described below:

Search time settings

a. Search start time - set the date and time in the format format is DD:MM:YYYY:hh:mm when

the PST Gatherer should start searching for PST files. To change the values, select the date,

month, year or time and then use the up or down buttons to increase or decrease the

value.

b. Search duration (minutes) - set the desired period in minutes. Consider a longer time

period for client computers where many PST files may reside because searching may take

time. For example, if the set of folders is limited to a 1000 folders, set the duration to 5

minutes. If the set of folders exceeds 100,000, set a duration of 15-30 minutes.

c. Interval (days) - set the search frequency in days.

Search options

a. Search PST files on the client computer - select this check box to search for PST files in local

drives and network shares.

b. Search PST files on the client computer Outlook profiles - select this check box to search

through all Outlook profiles for PST files.

c. Search and upload after logon  - select this check box to search for PST files immediately

after a user logs in. PST files will be uploaded immediately after search. 

NOTE: Search and upload will also be started at the time specified in the Search and

Upload tabs. However, if the computer is turned off or not connected to the network at

that time, no search or upload can be performed. If the above mentioned options are

checked, the client will be searched when available.
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3. Click OK to save the settings and close the window or click Apply to save and continue.

Steps to configure default upload settings

1. Click the Upload tab.

2. Specify the default values as described below:

Upload time settings

a. Upload start time - set the date and time in the format format is DD:MM:YYYY:hh:mm

when the PST Gatherer should start uploading the PST files. To change the values, select

the date, month, year or time and then use the up or down buttons to increase or decrease

the value.

b. Duration of upload (minutes) - set the desired upload period in minutes. Consider a longer

time period for client computers where many PST files may reside because uploading may

take time.

c. Interval (days) - set the upload frequency in days.

NOTE: If uploading starts before searching begins, PST files gathered during the

previous search are uploaded.

Upload options

a. Delete PST file from client computer after it is uploaded to the server - select this check

box to delete the PST files on the client computer after they are uploaded to the PST

Importer server. Selecting this option ensures that no PST file is imported twice. No PST

files will be lost because they will be moved to the PST Importer server and if the
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importing process is not completed, the file is not removed from the PST Importer server

either.

b. Remove the PST file from the Outlook profile after it is uploaded to the server - select this

check box to remove the PST file from the Outlook profile after being uploaded to the PST

Importer server.

c. Lock PST file on the client computer during upload - select this check box to lock the PST

files so that no other applications can use the files while they are being uploaded. 

3. Click OK to save the settings and close the window or click Apply to save and continue.

Manage client computers
Client computers can be added to the Clients list in three different ways:

· manually one-by-one. See Add a new client.

· by automatic registration. See Register new clients.

· by importing with a comma separated file. See Import new clients.

Other client management topics:

· Remove a client

· Modify client properties

· Deactivate a client

Add a new client

To add a new client computer manually:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The

Gatherer management window opens.

2. Click on the Add New Client icon on the toolbar, or from the main menu click Clients and then

select Add new client.

3. In the Add new client computer window enter NETBIOS name or the IP address of the client

computer.
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4. Click OK. The computer will be displayed in the Clients list.

NOTE: If the client computer cannot be added, the Status column of the Clients list displays

ERROR. Check for the following typical issues:

a. You entered an incorrect NETBIOS name or IP address.

b. Client computer is turned off.

c. PST Gatherer application or service on the client computer is not installed or not

running. You can start the Gatherer service on the respective computer from C:\Program

Files (x86)\Metalogix\MAM4Exchange\Tools\Start.

Register new clients

Instead of adding client computers one-by-one, you may want to add them automatically by

using the automatic registration as described below:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The

Gatherer management window opens.

2. From the main menu click Clients and then select Automatic registrations.
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3. In the Registered clients window select the check boxes for each client computer that you want

to add. You can click Check all to select all client computers.

4. Click Create. The selected client computers will be added to the Clients list.

NOTE: If the client computer cannot be added, the Status column of the Clients list displays

ERROR. Check for the following typical issues:

a. Client computer is turned off.

b. PST Gatherer application or service on the client computer is not installed or not

running. You can start the Gatherer service on the respective computer from C:\Program

Files (x86)\Metalogix\MAM4Exchange\Tools\Start.
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Import new clients

You can use an import file to add a large number of  pre-configured client computers. The import

TXT file format and considerations are described below:

Column name Value Description Example

Name string Computer name AMXWIN10

MBXID integer Mailbox identifier. Instead

of this column you can you

can use OwnerName column

6

DestinationFolder string Folder in the target mailbox

which will be the root folder

for the whole PST tree

structure.  If you intend to

import more than one PST

file to the same destination

mailbox, you can create

unique root folders for each

PST file by entering the

special tags described

below:

a. %PSTNAME% - the folder

name is the display name

of the PST file.

b. %PSTFILENAME% - the

folder name is the file

name (without

extension) of the PST file

%PSTFILENAME%

OwnerName string If you do not know the

mailbox identifier (MBXID),

you can specify the email

address or alias

timashford@democorp.c

om

SearchStart datetime Date and time when the

Gatherer should start

searching for PST files

21/1/2010 4:00:00 PM

SearchInterval integer Frequency of the search

(days)

1
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Column name Value Description Example

SearchDuration integer Duration of searching

(minutes)

20

UploadStart datetime Date and time when the

Gatherer should start

uploading of PST files

25/1/2010 4:00:00 PM

UploadInterval integer Frequency of the upload

(days)

1

UploadDuration integer Duration of searching (days) 30

a. The first line must contain the columns which are used in the file. The file need not contain all

columns. 

b. The column Name is mandatory

c. Column names are not case sensitive. 

d. Column names and values must be separated by either a semicolon (;) or a pipe (|). Only one

type of the separator should be used in the whole import file. 

e. The data types must be correctly formatted:

· String - any string that does not contain separator. The string cab be empty.

· Integer -only numeric values.

· DateTime - the format of the date depends on the regional settings of the computer where

the application is running.

To import new client computers with an import file:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The

Gatherer management window opens.

2. From the main menu click Clients and then select Import clients or click the Import clients icon

in the tool bar.
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3. In the Import PST Clients window click Import and locate the import file you have created.

4. Check the displayed report and the Clients list for imported clients.

5. Click Clear Report to erase the report contents and then click Close to exit the Import PST

Clients window.

Remove a client

When a client computer is removed, PST files cannot be uploaded from that client computer. To

remove a client computer:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The

Gatherer management window opens.
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2. Select the client computer and then you can remove the client in one of two ways:

a. Click the Remove Client icon on the toolbar.

b. From the menu click Clients and then select Delete client.

3. In the Information window that opens, click Yes to confirm.

Modify client properties

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The

Gatherer management window opens.

2. In the Clients list select a client computer. Open the Properties window in one of three ways:

· Double-click a client computer in the Clients list.

· From the main menu click Clients and then select Client Properties.

· Right-click a client computer in the Clients list and select Properties from the context menu.

3. From the Properties window select the Ownership tab.
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Customize the properties as described below:

a. Detect user from folder path - if PST files are stored on a network share or a disk and each

user has their own folder, then only this location will be searched on that client computer

and the PST files will be assigned to each user on the basis of the folder name. You can use

the following wildcards to detect assignees:

· %ALIAS%

· %DISPLAYNAME%

· %LOGONNAME%

· %EMAILADRESS%

For example, if user folders are created on the basis of their email address on a network

share called Archive, then you can use the folder path \\Alias\%EMAILADRESS% to search

for PST files in these folders and assign each PST file to a unique user mailbox.

b. You can customize other settings in the Ownership, Search and Upload tabs as described in

the Setup PST Gathering topic.

Deactivate a client

If you want to temporarily prevent a client computer from automatically uploading PST files you

can deactivate the client instead of removing it. If a client is deactivated, manual uploading and

importing of PST files can still be performed. Manual uploading is an independent process from

automated uploading.

To deactivate a client computer:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The

Gatherer management window opens.

2. Right-click the client that you want to deactivate and select Deactivate client from the context

menu.
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3. A deactivated client is displayed with a red mark in the icon.

NOTE: A deactivated client computer can be activated again. Right-click a deactivated client

in the Clients list and select Activate client from the context menu. 

Manage PST files
In this topic:

· Deactivate automatic upload

· Modify PST Properties
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Deactivate automatic upload

To prevent uploading a PST file :

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The

Gatherer management window opens.

2. Select a client from the Clients list. The PST files found by the PST Gatherer are displayed in

the Files list. 

3. Right-click a PST file and then select Deactivate automatic upload from the context menu. The

status of the Upload column changes to No.

NOTE: Deactivated PSTs can be activated again. Right-click a deactivated PST file and then

select Activate automatic upload from the context menu. The status of the Upload column

changes to Yes.

Modify PST Properties

To change properties of a PST file:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. The

Gatherer management window opens.

2. Select a client from the Clients list. The PST files found by the PST Gatherer are displayed in

the Files list.

3. Right-click a PST file and then select Properties from the context menu.
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4.  In the Properties window that opens, modify the properties as described below:

Settings tab

a. Target mailbox - sets a specific owner mailbox for the PST file. To change the target

mailbox, click Browse to open the Select mailbox window and choose the new owner

mailbox. Click Default to reset the mailbox to the default setting. You can also right-click

the PST file and select the Change PST file owner from the context menu

b. Default folder - select this option to use the default folder.

c. Specific folder - select this option to define a specific target folder. Either type the mailbox

folder name in the text box or use the Browse button to select a mailbox folder.

NOTE: If you intend to import more than one PST file to the same target mailbox,

you can create unique root folders for each PST file by entering the special tags

described below:
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a. %PSTNAME% - the folder name is the display name of the PST file.

b. %PSTFILENAME% - the folder name is the file name (without extension) of the

PST file

For example, if Maya-2019.pst is the file name of the PST folder being imported and

you enter PST Archive/%PSTFILENAME% in the Destination folder, then a folder

hierarchy will be created under the destination mailbox root as PST Archive > Maya-

2019.

d. Allow to upload file to server - allows the PST file to be uploaded. If this check box is not

checked the PST file will not be uploaded.

e. Always analyze before import - select this check box to use the Analyze function to identify

a PST owner.

Details tab

a. If the PST file is password protected, enter the password in the Password field and re-

enter the password in the Confirm password field.

5. Click OK to save the settings and exit the window or click Apply to save and continue.

Search for PSTs immediately
Searching for PST files on a specific client computer starts automatically at the start time

specified for that specific computer. You can start searching for PST files immediately if

necessary. 

To start searching immediately:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. 

2. In the Gatherer management window right-click the client you want to search. Select Tasks >

Search from the context menu. Searching starts immediately.
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3. Click the Refresh icon in the toolbar to view the results in the Files list. It may take a while

(maybe several minutes) to display the PST files as it depends on the number of disks that

have to be searched through, their size, and the number of files that have to be screened. 

NOTE: To clear the search results list when performing a new search, open PST Importer.

The click Tools > Options to open the Options window. On the Default tab select the Clear

existing list before a new search check box and save the setting.

Upload PSTs immediately
Files found by the PST Gatherer will be uploaded automatically depending on the upload start

time specified for that client computer. You can start uploading PST files immediately if

necessary.

To start uploading PST files immediately:
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1. From the PST Importer menu click PST Gathering and then click Clients and PST files. 

2. In the Gatherer management window right-click the client for which you want to start the

immediate upload. Select Tasks > Upload from the context menu. PST file upload starts

immediately.

3. Click the Refresh icon in the toolbar and check the Status column in the Files list. The status

value changes from UPLOADING to UPLOADED or ERROR as files are uploaded.

4. If the upload status indicates ERROR then the PST file could not be uploaded. There could be

several reasons. For example, the file was deleted from the disk or the file was removed from

its original path after a search action. To analyze the error, right-click the PST file and select

Show error information from the context menu.
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NOTE: To re-upload one or more specific files from the Files list, initiate a search action on

the same client computer as described in the Search for PSTs immediately topic. When the

file gets displayed in the Files list, right-click the file and select Upload file(s) from the

context menu.

Import and archive uploaded PST files
PST files are imported by the PST Import wizard to their destination mailboxes and destination

folders and then archived. 

To import and archive uploaded files:

1. From the PST Importer menu click PST Gathering and then click Clients and PST files. 

2. In the Gatherer management window click the Import wizard icon to open the PST Import

wizard.

3. The Mailbox Action window displays the list of uploaded PST files. Select the files which you

want to import.
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4. Click Next. The Summary window opens. Verify that the PST files selected for import appear

in the Summary list.

Number of threads - set the number of threads to process the import. The more the threads,

the higher is the import speed. However, it means also a higher network load. 

5. Click Finish to start the import. 

6. Click Close when the import completes. Imported and archived PST file status in the Files list

of the Gatherer management window changes to PROCESSED.
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Troubleshooting

7

Cannot import PST file of any type

Probably the MAPI is not configured to use Microsoft Outlook data files (PST files).

Details: To use PST files in MAPI profiles, the Extended MAPI must know how to handle them.

The MAPISVC.INF file must contain the correct service provider entry to successfully use PST

files in Archive Manager.

If the MAPI subsystem is installed along with the MS Exchange Server, the MAPI binaries and the

MAPISVC.INF file are located in the folder c:\Program Files\Common

Files\System\Mapi\1033\NT. If the MAPI is installed along with MS Outlook, the binaries

are located in c:\WINNT\system32.

The [Services] section should contain the following entries:

MSPST MS=Personal Folders

The service definition:
[MSPST MS]

Providers=MSPST MSP

PR_SERVICE_DLL_NAME=mspst.dll

PR_SERVICE_INSTALL_ID={6485D262-C2AC-11D1-AD3E-10A0C911C9C0}

PR_SERVICE_SUPPORT_FILES=mspst.dll

PR_SERVICE_ENTRY_NAME=PSTServiceEntry

PR_RESOURCE_FLAGS=SERVICE_NO_PRIMARY_IDENTITY

[MSPST MSP]

34140102=4e495441f9bfb80100aa0037d96e0000

PR_PROVIDER_DLL_NAME=mspst.dll

PR_SERVICE_INSTALL_ID={6485D262-C2AC-11D1-AD3E-10A0C911C9C0}

PR_RESOURCE_TYPE=MAPI_STORE_PROVIDER

PR_RESOURCE_FLAGS=STATUS_DEFAULT_STORE

PR_DISPLAY_NAME=Personal Folders

PR_PROVIDER_DISPLAY=Personal Folders

The same for [MSUPST MS] service.

Symptoms: If the above service providers are missing in the MAPISVC.INF file, the following

error is displayed by Archive Manager (in debug output) when importing a PST file:

CProfileManager::PSTAdd >> Cannot create msg service MSPST MS
8004010F
CProfileManager::PSTAdd >> Exception 8004010F
CProfileManager::PSTAdd >> Cannot create msg service MSPST/MSUPST
MS %08X
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CProfileManager::PSTAdd >> Cannot create msg service MSUPST MS
8004010F
CProfileManager::PSTAdd >> Exception 8004010F
CProfileManager::PSTAdd >> Cannot create msg service MSPST/MSUPST
MS %08X

Remark: The error code 8004010F stands for MAPI_E_NOT_FOUND and indicates that the

required data was not found on the object. (e.g. the MSPST MS service provider was not found)

Cannot import Unicode PST files

Probably the MAPI is not configured to use Unicode PST files or no Outlook was installed on the

PST Importer server.

Details: The service provider MSUPST MS must be included in the MAPISVC.INF file. For

detailed description of the MAPISVC.INF file see question Q1.

Symptoms: The following lines can appear in the debug output:

CProfileManager::PSTAdd >> Cannot create msg service MSUPST MS
8004010F
CProfileManager::PSTAdd >> Exception 8004010F
CProfileManager::PSTAdd >> Cannot create msg service MSPST/MSUPST
MS %08X

Remark: The error code 8004010F stands for MAPI_E_NOT_FOUND and indicates that the

required data was not found on the object. (e.g. the MSPST MS service provider was not found)
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Quest creates software solutions that make the benefits of new technology real in an

increasingly complex IT landscape. From database and systems management, to Active Directory

and Office 365 management, and cyber security resilience, Quest helps customers solve their

next IT challenge now. Around the globe, more than 130,000 companies and 95% of the Fortune

500 count on Quest to deliver proactive management and monitoring for the next enterprise

initiative, find the next solution for complex Microsoft challenges and stay ahead of the next

threat. Quest Software. Where next meets now. For more information, visit www.quest.com.

Contacting Quest
For sales or other inquiries, visit www.quest.com/contact.

Technical Support Resources
Technical support is available to Quest customers with a valid maintenance contract and

customers who have trial versions. You can access the Quest Support Portal at

https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and

independently, 24 hours a day, 365 days a year. The Support Portal activates you to:

· Submit and manage a Service Request

· View Knowledge Base articles

· Sign up for product notifications

· Download software and technical documentation

· View how-to-videos

· Engage in community discussions

· Chat with support engineers online

· View services to assist you with your product

https://www.quest.com
http://www.quest.com/contact
https://support.quest.com

	Introduction
	Installation
	Configuration
	Log files
	Manual import
	Loading a PST file
	Preparing a PST file
	Viewing a PST file summary
	Analyzing a PST file
	Importing a PST file

	Automated import
	Install PST Gatherer
	Setup PST Gathering
	Manage client computers
	Add a new client
	Register new clients
	Import new clients
	Remove a client
	Modify client properties
	Deactivate a client

	Manage PST files
	Deactivate automatic upload
	Modify PST Properties

	Search for PSTs immediately
	Upload PSTs immediately
	Import and archive uploaded PST files

	Troubleshooting
	About Us
	Contacting Quest
	Technical Support Resources


